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Overview

The increased scrutiny on staffing data collection and its relationship with patient safety has revealed

something interesting.

Although directors of nursing and other clinical services have been collecting staffing data for years, most

lack a consistent process or approach for collecting this data. As a result, these directors have no idea

where to begin in establishing staffing norms and practices on their units.

Enter the Staffing Analyzer.

In addition to organizing your staffing data, the Staffing Analyzer allows users to customize dropdown

menus to provide answers to the following questions:

• What is the reason for the over/understaffing for that shift?

• What was the intervention used (action taken) to address the underage or overage?

The Staffing Analyzer organizes per-shift data daily for each unit for a week’s worth of data. The spread-

sheet will then aggregate the data over a week’s time to arrive at trends for that week.

Each unit’s manager is meant to enter the data for her or his unit only, then forward the data on a weekly

or monthly basis to the director of nursing or a nurse administrator.

The spreadsheet is designed to create and display presentation charts and graphs of staffing variances, rea-

sons for variance, and interventions so that managers at the unit level and director level can identify and

present trends more easily.

US E R M A N UA L
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The Staffing Analyzer is the only resource you will need to set up a process for analyzing staffing data or

revitalize the one you already have.

Getting started

Everything you need to get the Staffing Analyzer up and running on your computer is included on the

CD/ROM that accompanies this book. Here are answers to common questions about how to get your

version of the Staffing Analyzer up and running.

What type of computer do I need to use the Staffing Analyzer?

The Staffing Analyzer must be used on a personal computer (PC) that includes Microsoft Excel software.

The Staffing Analyzer cannot be used on a Macintosh computer at this point in time.

How do I install and open the Staffing Analyzer on my computer?

1. Place CD/ROM in your computer’s CD/ROM drive

2. Double-click on your CD drive

3. Find the file called RN STAFF v1.5 and double-click on it

The Staffing Analyzer workbook should now be open on your monitor.

How do I save a template copy of the Staffing Analyzer on my computer?

1. Go to the File menu, point to Save As

2. In the File name box, enter a new name for the file: Staffing Analyzer Template

Where is the best place to save the Staffing Analyzer on my computer?

It is at this point that you will need to decide where you would like to store your Staffing Analyzer Template.

There are a number of suggested places:

1. A folder on your computer’s hard drive called “My Documents” or “My Programs,” either of

which may be the default setting for your computer

2. A new folder on your hard drive
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3. Your desktop

4. A folder on the facility’s computer network

It is up to you to decide where to save it. We suggest you save it to your facility’s network and backup

your work frequently. It doesn’t matter if you choose one of these four suggestions or use one of your

own. The only requirements are that wherever you decide

• you know where you are

• you know how to get back there

What is the best method for sharing the Staffing Analyzer with colleagues?

Perhaps you have more than one nurse manager or senior staff nurse responsible for analyzing and pre-

senting staffing levels data within your organization. There are two easy ways to share the Staffing

Analyzer:

1. Store your version of the Staffing Analyzer Template on to your facility’s network in a location

where everyone who needs to use the tool can access it

2. Give CD/ROM to your colleague and have him or her download a copy of the Staffing Analyzer

Template on his or her computer

Enabling and disabling macros

When you open the Staffing Analyzer, you will be notified that this tool “contains macros” that may not

work due to your computer’s security settings.

A macro is a single instructional command that is embedded in the tool and stands for a sequence of

operations. In this case, the macros are tied to the operation of the tool’s dropdown menus.

To use the Staffing Analyzer you need these macros to be enabled. When the warning box appears, click

Enable Macros.

If your computer does not allow you to enable macros, you may need to change your computer’s security

settings. Consult your technology department before you attempt this.
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The Staffing Analyzer is a Microsoft Excel workbook. An Excel workbook is a file that con-

tains one or more worksheets. Worksheets are your primary documents for storing and

working with data. 

Worksheets are sometimes called spreadsheets. Each worksheet consists of cells that are

organized into columns and rows; worksheets are always stored in a workbook.

Moving between worksheets
The Staffing Analyzer is an Excel workbook that features nine worksheets, labeled as fol-

lows:

1. Configuration Data 

2. Weekly Summary

3. Day 1

4. Day 2

5. Day 3

6. Day 4

7. Day 5

8. Day 6

9. Day 7

The easiest way for you to move from one worksheet to another is by clicking the sheet

tabs at the bottom of the workbook window. Each worksheet has its own tab. The tab of the

active worksheet (the worksheet in which you are working) is colored white. 

Selecting cells
Point and click on the desired cell. 

Moving between cells 
¥ Use the arrow keys to move one cell, up, down, to the right, and to the left

¥ Press the TAB key to move one cell to the right

¥ Press the RETURN key to move one cell down

Microsoft Excel refresher course
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Customizing your Staffing Analyzer 

Every health care organization faces its own unique set of staffing challenges, and each responds to those

challenges in a different way. Therefore, no two organizations that use the Staffing Analyzer will do so in

the same way.

That is not to say there are not staffing challenges and responses that are universal. Every nursing super-

visor has had a staff member call out sick or go on vacation, jury duty, and so on. Further, every nurse

manager has, in turn, offered another staff member overtime compensation for covering that shift.

Editing cell contents
1. Double-click the cell that contains the data you want to edit

2. Edit the cell contents

3. To enter or cancel your changes, press ENTER or ESC

Clearing/deleting cell contents
When you clear cells, you remove the cell contents (formulas and data), formats (including

number formats, conditional formats, and borders), or comments, but you leave the blank

cells on the worksheet.

1. Select the cells, rows, or column you want to clear any contents

2. On the Edit menu, point to Clear and then click All

When you delete cells by clicking Delete on the Edit menu, Microsoft Excel removes them

from the worksheet and shifts the surrounding cells to fill the space. All the cells in the

Staffing Analyzer workbook, however, are locked and cannot be deleted. 

Undoing/redoing an action
1. To undo actions one at a time, go to the Edit menu and click Undo Typing

2. If you change your mind, go to the Edit menu and click Redo Typing

Microsoft Excel refresher course (cont.)
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We recognized these facts when we designed the Staffing Analyzer. We have provided some of the more

frequently identified reasons for staffing variances and responses taken to correct those variances. You

will also notice we have left several cells blank, anticipating that this is where you will add your unique

reasons for staffing challenges and interventions.

Keys to customizing

The key to effectively analyzing staffing data with this tool relies on your ability to individualize, or cus-

tomize, this tool to reflect your organization’s

1. staffing types

2. shift changes

3. reasons for under/overstaffing challenges

4. the typical responses or actions taken to remedy those challenges

Fortunately for you, customizing this tool is simple, and can all be done in one place—the Configuring

Data worksheet. (See Figure 1.1.)

This is the first worksheet in the Staffing Analyzer workbook. If you are not there already, click on the

Config Data tab at the bottom of the workbook.
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Changing the organization name, department name, and week beginning date

Your first customization responsibility is to customize the three cells that contain the Staffing Analyzer’s

default organization name, department name, and week beginning date.

When you open the Staffing Analyzer for the first time, it will include a cell for you to type in the name

of your organization. It is cell A9 on the Configuring Data worksheet.

F IGURE 1 .1

Configuring Data Worksheet
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Editor’s note: When we refer to specific cells in a worksheet in this book, we will use the letter that corre-

sponds to the column heading and the number that corresponds to the row heading. This is similar to the

way you find locations on a map.

To replace the default name (“Hospital Name”) with the name of your organization:

1. Click on cell A9

2. Type the name of your organization over the current name

This simple change is important, and it will save you a good deal of time when you present 

your data.

When your data appears in the graphs discussed later in the Presenting Your Data section, it 

will automatically be stamped with the name of your organization thanks to this first customization step.

Use the same procedure to change the Department Name in cell A11 from the default (“ICU”) to the

department for which you will be entering data.

Again, follow the same procedure for entering the Week Beginning date in cell A13. Refer to 

Figure 1.1.

Customizing the tool to reflect your organization

We’ve already done one customization step for you. This appears in the Varience Due To column (Column

C).

There are only two indicators to describe the variance between your actual staffing data (the number of

staff you had working in the department or unit) and your pattern staffing data (the number of staff you

had in your budgetary plan for that department or unit) for each staff type on each shift. The Staffing

Analyzer’s two suggested indicators are simply Overstaffed and Understaffed.

1. Overstaffed—Your actual staffing data is greater than your budgetary staffing plan (pattern data)

2. Understaffed—Your actual staffing data is less than your budgetary staffing plan (pattern data)
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If your actual and pattern staffing data are equal (the variance is zero), you are neither overstaffed nor

understaffed.

There are four remaining items on this worksheet that need to be customized to fit your organization or

facility:

1. Reason for variance 

2. Intervention

3. Shifts

4. Staffing types

Each of these four items appears as a heading above a yellow column on the Config Data worksheet.

These yellow cells beneath those column headings contain the default (or suggested) indicators for those

headings.

Customizing your dropdown menus
The first two customizable columns, reason for variance and Intervention, will appear in the dropdown

menus you will use later on the day-specific worksheets. We will discuss how to use these dropdown

menus later, in the Entering Your Data section of this chapter.

Remember that the suggested indicators that appear in these columns are just that—suggestions. It is pos-

sible that every organization that uses this tool will have a unique set of indicators for these categories.

Your diligence in customizing these dropdown menus will determine the effectiveness of this tool. Keep in

mind that you can use

• all of these indicators as they are written

• some of these indicators and edit others

• some of these indicators and leave the rest blank

• none of these indicators and enter your own

Or, you can do any combination of the above suggestions.
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Before you can decide whether our suggested indicators are right for your organization, you need clear

definitions of what each option means. To help you decide, we have included a column-by-column

description of the options we have included for you in the Staffing Analyzer below.

Whichever indicators you choose to create, keep the wording short. These indicators will show up later

on bar charts. Indicators that are long or wordy may affect the appearance of the charts.

1. Reason for variance

This column is where you create the typical reasons that may explain why one of your particular staffing

types was under/overstaffed in a particular department during a particular shift.

The Staffing Analyzer’s suggested Reasons for variance options appear in the first yellow column on the

Configuring Data worksheet (Column F). An enlarged copy of the column appears in Figure 1.2.

There are four suggested indicators. Below those indicators are six blank cells where you may enter 

additional indicators.

F IGURE 1.2

Reason for variance
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The suggested indicators are listed below. The description for each reason (indicator) completes the fol-

lowing sentence:

You would use this indicator if the reason you were under/overstaffed was because

Skill mix—The various skill levels of staff were inappropriate based on patient acquity, skills required,

and the roles and responsibilities assigned to each through licensure and job descriptions.

Change in census—The number of patients you cared for on the unit that day increased or decreased.

This indicator might be used to show a shift in which your unit provided care to transfers from another

unit.

Change in acuity—The acuity level of the patients you cared for on the unit that shift increased or

decreased. This indicator might be used to show a day in which your medical/surgical unit provided care

to patients transferred from the intensive care unit, who require nurses with a higher skill level.

Staff absenteeism—A scheduled member of your staff did not show up for his or her shift (i.e., vacation,

illness, jury duty, and so on).

See Chapter four for more detailed explanations of these indicators and further discussion.

2. Intervention

As was the case with your Reason for variance indicators, there are any number of interventions 

(action taken) that could be used to describe your response to an under/overstaffing problem.

The Staffing Analyzer’s suggested Intervention indicators appear in the second yellow column 

(Column I) on the Configuring Data worksheet. An enlarged copy of the column appears in 

Figure 1.3. There are seven suggested Intervention indicators and eight blank cells where you may add 

additional indicators.

In order to solve your under/overstaffing problem during this particular shift

Call house staffing—You called in another full-time employee of the facility to work that shift 

on your unit



F IGURE 1.3

Intervention
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Call PRN (as needed) and part-time employees—You called in PRN and part-time employees 

of your facility who work fewer than 40 hours per week and therefore would not need to be paid 

overtime.

Staff offered overtime—You offered overtime wages to the current staff on the unit during that 

shift to entice them to stay for an additional shift

In-house registry—You contacted the nursing office’s registry, a group of employees who had previously

expressed interest in overtime hours whenever they are made available

Agency—The hospital contacted an outside nursing agency that sends over a contract nurse

Transfer staff to another unit—A nurse on your unit was transferred out because you are overstaffed



F IGURE 1.4
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Staff sent home—A nurse on your unit was sent home because of a change in census

See Chapter four for more detailed explanations of these indicators and further discussion.

The final two pieces of the Configuring Data worksheet that need to be customized before you 

begin entering data are the shifts and staffing types columns.

3. Shifts

The Staffing Analyzer’s suggested shift starting times appear in the third yellow column (Column L) 

on the Configuring Data worksheet.

An enlarged copy of the column appears in Figure 1.4.
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These suggested shift starting times can be changed to better reflect the shift changes at your facility.

In fact, they do not need to be designated as a time of day at all.

You can change the shift times to shift names or simply rename them 1st shift, 2nd shift, or 3rd shift,

and so on. You do not need to customize or use all five shifts—you can use only two or three if that 

is all your organization typically uses.

4. Staffing types

The Staffing Analyzer’s suggested staffing types appear in the fourth yellow column (Column O) 

on the Configuring Data worksheet. An enlarged copy of the column appears in Figure 1.5.

F IGURE 1.5

Staffing types
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The column includes three suggested staffing types and two blank cells for tracking other staffing types

at your organization.

The suggested acronyms are as follows:

RN—Registered Nurse 

LVN/LPN—Licensed Vocational Nurse/Licensed Practical Nurse 

NT—Nurse Technician

This list may not be an accurate representation of the staff at your facility. It is up to you to customize

this list to better resemble the staff at your facility. You can change any, none, or all of these suggested

staffing types.

Changing the indicators
We cannot emphasize enough that these indicators and options can be changed at any time.

After using the tool for a month, you may discover newer, more specific reasons for your 

over/understaffing that are more effective than the options you originally created. Or you may 

find that an intervention (action taken) that was common when you customized this tool the 

first time is now discouraged by your administration or perhaps illegal due to new state or 

federal regulations.

The customization of this tool should be an ongoing process. There should be regularly scheduled 

assessments, under the supervision of the user, to determine whether the current options best reflect 

the current staffing challenges and action taken at your organization.

Editor’s note: Whenever you do make a change to the indicators, develop a process for documenting 

the date when that change occurred. In some instances this will help you to explain unexpected data

trends. For example, you notice a sharp spike in the times you called in agency nurses occurred in the

first two weeks of November. What caused this spike? A look back at your record of changes reveals that

you added an option to your Reason for variance menu on November 1, reflecting the nursing

strike that began on that day.
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Entering your data into the Staffing Analyzer 

Now that you have finished customizing the Configuring Data worksheet, you can start entering

your staffing data into the day-specific department worksheets.

For the purpose of this manual, assume the following scenario:

You have collected staffing data taken from your facility’s Intensive Care Unit (ICU) on 

December 8, 2003.

That day you had four RNs, five LVNs, and six NTs on duty.

The budget called for five of each.

If you are not already in the worksheet titled Day 1, click the tab called “Day 1” at the bottom of the

workbook. First, verify that Department Name and Date appear correctly at the top of worksheet in

which you are working. If the either, or both, are incorrect, turn back to the Customizing your 

Staffing Analyzer section to learn how to customize these items.

You can choose to enter your data into the day-specific worksheets any number of ways.

The two most logical ways to enter data are:

• Horizontally—by shift 

• Vertically—by staffing type 

If you choose to work horizontally, start at Cell D4 and work left to right to enter the actual and 

pattern data for every staff type on the unit during your first shift of the day. After your first shift,

move down the sheet to your second shift and work horizontally, left to right once again, entering 

data for each staff type on the unit during the second shift, and so on.

If you choose to work vertically, you will also start at Cell D4, but enter the actual and pattern data

for one staff type throughout all of the shifts at your facility. When you reach the bottom of the 

staffing type column, move back to the top of the worksheet and enter data down the sheet for

the next staffing type.
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No one way is better than the other. Your decision will likely be based on the way in which the staffing

data you collected is organized. If the unit-specific staffing data you are entering is organized by shift, it

will probably be easier to work horizontally. If your unit-specific staffing data is organized by staff type,

it will probably be easier to work vertically.

Step 1: Entering actual data, pattern data, and determining the variance
The first section of the day-specific worksheet that requires you to enter your staffing data involves

entering your actual staffing data, entering your pattern staffing data, and then recognizing and

understanding the variance.

Begin by entering your staffing data for the 7 a.m. shift. The section of the day-specific worksheet in

which you will be working appears in Figure 1.6.

F IGURE 1.6

Day 1, screenshot #1
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Actual data

Actual data is the number of staffing type members you had in the selected unit during the selected shift

on the selected day.

1. Click on Cell D4 on your worksheet.

2. Enter the number of RNs, LVNs, and NTs you had in the ICU during the 7 a.m. shift.

(See Figure 1.7).

3. Press ENTER.

Pattern data

Pattern date is the number of staffing type members you had budgeted for the selected unit during the

selected shift on the selected day.

1. Click on Cell D5 on your worksheet.

2. Enter the number of RNs, LVNs, and NTs you had budgeted to be in the ICU during the 7 a.m. shift.

(See Figure 1.7).

3. Press ENTER.

Variance

The variance, which is the numeric difference between your pattern and actual data, appears 

beneath your actual and pattern data, in Cell D6.

A formula imbedded in each staffing type column of the department worksheet calculates the variance 

for you. The variance will appear as either a negative number, positive number, or zero.

The data for the “Variance due to:” cell is automatically generated by the Staffing Analyzer as well. It is

based on the variance value (Cell D6 in this case).

When the variance is a negative number, the word “Understaffed” will appear in the cell.

When the variance is a positive number, the word “Overstaffed” will appear in the cell.

When the variance is zero, the cell remains empty.
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For examples of all three of these variance options, refer to the screenshot in Figure 1.7.

Totals

If you are looking for the day’s total variance by shift, it is automatically generated by the Staffing

Analyzer. Scroll over to Column O on your worksheet, which is titled “Total Variance” to see the totals.

If you are looking for the day’s total variance by staffing type, it is automatically generated by the

Staffing Analyzer as well. It appears in Row 72, titled “Total Variance by Staffing Type,” and located

beneath each of the staffing type columns.

F IGURE 1.7

Day 1, screenshot #2
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If you scroll down below Row 72, you will also find a chart that includes the daily total for 

the following:

• Variance due to

• Reasons for variance

• Interventions

The chart also summarizes the totals mentioned above:

• Variance by staffing type

• Variance by shifts

If you are having trouble finding this chart, scroll down to the royal blue section of the day-specific

worksheet. The chart begins on the first row of this section, Row 73, and runs down to Row 89.

Step 2: Choosing a reason for variance
In Step 2, you will use a dropdown menu you customized earlier to select the reason that best explains

why there was a variance between your actual and planned data (i.e., Why were you under/overstaffed?)

For the purpose of this example, assume that your ICU was understaffed by one RN during the 7 a.m.

shift because one of your RNs called in sick. Here’s how you would use the Staffing Analyzer to show

this fact: 

Take a look at the screenshot in Figure 1.8.

1. Click on the down arrow in the box on the right side of Cell D10. A dropdown menu will appear.

2. Drag your cursor down to the fourth indicator on the list, “Staff Absenteeism,” or the indicator that

best represents your reason. (For an explanation of this indicator and the others on the list, see

Chapter four.)

3. Left-click on this indicator.

The Staffing Analyzer places your selection in Cell D10.



F IGURE 1.8

Day 1, screenshot #3
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Step 3: Selecting interventions (Intervention 1 and Intervention 2)

In Step 3, you will use the remaining dropdown menu you customized to select either one or two 

interventions undertaken to solve the under/overstaffing problem that occurred in the unit on this 

particular shift.
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Take a look at the screenshot in Figure 1.9.

Editor’s note: Note that the reason for variance you selected in Step 2 now appears in Cell D10.

Continuing with our sick RN scenario, let’s assume that your one attempt to solve the RN understaffing

problem during the 7 a.m. shift was to a call to an in-house nurse working in another department. Here

is how you would use the Staffing Analyzer to show this fact:

1. Click on the down arrow in the box on the right side of Cell D12. A dropdown menu will appear.

2. Move your cursor to the first intervention, “Call house staffing,” or the indicator that best repre-

sents your intervention. (For an explanation of this or other intervention indicators on the list, see

Chapter four.)

3. Left-click on this indicator.

F IGURE 1.9

Day 1, screenshot #4
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The Staffing Analyzer places your selection in Cell D12.

Most of your under/overstaffing problems will not have initiated more than one intervention. If you only

used one intervention, leave the cell for Intervention 2 (Cell D14) blank. If, in this case, you did use a sec-

ond intervention, repeat the procedure for entering Intervention 2.

Erasing/changing a dropdown menu option you have already selected
There will be instances where you make a selection from the dropdown menu that you later decide was

incorrect. How do you go back and change that?

If you realize another option on the dropdown menu is more appropriate, click on the cell with the incor-

rect information and use the down arrow to find and select another option.

If you realize that there is no option that is appropriate or necessary, highlight the complete text of the

option selected and press DELETE on your keyboard.

Data in this cell is connected to a dropdown menu, therefore, clicking on the cell and retyping will not

erase the option (as is the case with other cells).

When none of the dropdown menu indicators are applicable

If the most applicable reason for your staffing variance or intervention undertaken to solve your staffing

problem does not appear on the respective dropdown menu, you have two options.

1. Leave the cell blank. This is best for one-time or infrequent incidents that you do not wish to

track.

2. Go back to the Configuring Data worksheet and customize your Intervention dropdown menu

again, adding the applicable reason. This is best if you plan on analyzing or tracking that reason.

As discussed in the Customizing Your Staffing Analyzer section, putting “None” or “Not Applicable” will

mean these “interventions” will be tracked and will appear on your graphs.
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Presenting your data

The Staffing Analyzer is not simply a replacement for your paper and pen process for collecting and

organizing your staffing data. This tool takes it one step further by presenting the results in uncomplicat-

ed bar charts that can be easily included in any presentation or proposal.

Each of these full-color charts is automatically stamped with your organization’s name and the date, and

can be printed separately in hard-copy form or pasted into another computer application in electronic

form.

The daily bar charts, which reflect the data you entered for that particular day in that particular depart-

ment or unit, can be viewed at any time by scrolling down each day-specific worksheet to Row 91. The

bar charts run from Row 91 to Row 332.

There are five bar charts on each day-specific worksheet. They are titled the following:  

1. Variance due to

2. Variance by shift

3. Variance by staffing type

4. Reason for variance

5. Interventions

On all of the bar charts, the customized indicators you created on the Configuring Data worksheet

appear on the horizontal axis (x-axis). The vertical axis (y-axis) represents the number of times each of

the indicators was selected.

These bar charts also appear on the Weekly Summary worksheet. (To go to the Weekly Summary work-

sheet, click on the tab titled “Weekly Summary” at the bottom of the workbook.) 

The charts included on the Weekly Summary worksheet reflect all of the data from the bar charts on each

of the day-specific worksheets. The Staffing Analyzer condenses a week’s worth of staffing data from this

particular department or unit into the charts on this one page instantly, as you work.
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Explanation of charts

Below are examples of the Staffing Analyzer’s bar charts. These sample charts were taken from the tool’s

Weekly Summary worksheet. They are based on fictional data collected for an ICU for the week of December

8, 2003. The ICU includes three staffing types (RNs, LPNs, and NTs) and four shifts (starting at 7:00, 11:00,

15:00, and 19:00). The data in these examples were exaggerated to better show variation in the graphs.

1. Variance due to

The bar chart in Figure 1.10 represents how many times during the week your unit was understaffed or

overstaffed, factoring in all shifts and all staffing types. In other words, for each staffing type and shift,

this chart shows how many times there was a variance between your actual and planned staffing data.

During the week of December 8 the ICU was understaffed 30 times and overstaffed 10 times, according

to this chart. For the remaining shifts and staffing types there was no variance between actual and

planned staffing data.

F IGURE 1.10

Variance due to bar chart

ICU Week Begnining 12/8/2003
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2. Variance by shift

The bar chart in Figure 1.11 shows the total variance for each shift of the day across an entire week in

the unit. Each bar on the chart represents a daily shift in the ICU. The bar on the far right of the graph

represents your total variance across all of your shifts.

According to this bar chart, the ICU had understaffing problems in all but the last shift of the day. The

understaffing problem was worst during the 11:00 a.m.

F IGURE 1 .11

Variance by shift bar chart

ICU Week Begnining 12/8/2003
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3. Variance by staffing type

The bar chart in Figure 1.12 is a representation of the daily total variance for each staffing type on your

unit. Each bar represents a staffing type at your facility. The bar on the far right of the graph represents

your total variance for the week.

This week in the ICU there was an understaffing problem for all three staffing types. The most serious

deficiency was with your LPN staff. There were 21 instances during the week in which a shift was under-

staffed by LPN.

F IGURE 1.12

Variance by staffing type bar chart

ICU Week Begnining 12/8/2003
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4. Reason for variance

The graph in Figure 1.13 illustrates how many times you assigned a particular reason for a variance dur-

ing the week. Each of the bars represents one of the indicators you created on your Reason for variance

dropdown menu.

According to this graph, the reason most often cited for your under/overstaffing problem in the ICU this

week was due to a change in census.

F IGURE 1.13

Reason for variance bar chart

ICU Week Begnining 12/8/2003
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5. Interventions

The graph in Figure 1.14 shows how many times you used a particular intervention (actions taken) to

correct a variance between your actual and pattern staffing data during the week. Each of the bars repre-

sents one of the indicators you created on your Interventions dropdown menu.

According to the graph, your most frequent response to under/overstaffing problems this week in the ICU

was to offer overtime to staff, followed by transferring staff to another unit (to correct an overstaffing

problem), and calling house staffing.

We will discuss how these charts can be used to identify and analyze trends and lead to more effective

presentations throughout the remainder of this book.

F IGURE 1.14

Interventions bar chart

ICU Week Begnining 12/8/2003
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Printing or copying charts for presentations

When it comes time to present this data to administrators, JCAHO surveyors, state licensing officials,

staff, or anyone else who may be interested, there are easy steps you can follow in order to create hard-

copy or electronic versions of these bar charts.

Creating a hardcopy version of a bar chart

1. Move your cursor on to the graph you would like to print.

2. Left-click anywhere on the graph.

3. On the File menu, point to Print.

Including the bar chart in a PowerPoint slide show presentation (and other applications)

1. Move your cursor on to the graph you would like to copy.

2. Right-click anywhere on the graph except between the x- and y-axis and point to Copy.

3. Go to the destination document in which you would like the graph to appear. Right-click and 

point to Paste.

For more suggestions and guidance on presenting your data, including descriptions of other chart

options, refer to Chapter six.

Now that you know how to get the most out of the Staffing Analyzer, it’s time to examine how best 

to collect, analyze, and present staffing data.
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